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CHAPTER 2 

Getting Started 

Welcome to the user’s guide for you.trace.it, the 
material tracking & tracing and product quality 
management software.  

Read this chapter to become familiar with the 
general functionality of you.trace.it, its system 
requirements, the installation procedure, the work 
area, program navigation and toolbars. 
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Introduction 

What is you.trace.it 

Requirements for traceability solutions differ from business to business. Every article 
requires a different approach and manufacturers want to keep records that relate to 
their own production process. 

you.trace.it is Tracewise’s database-driven traceability and quality management 
solution. Thanks to the unique VBScript modelling environment (*), the software can be 
customised to meet the requirements of any business or any kind of process. 

(*) you.model.it is the integration toolbox for you.trace.it. It allows to define how 
traceability records are kept for an organisation, what information must be stored, the 
functionality of you.trace.it, etc. 

 

Software functionality 

The major components in you.trace.it are process stages. They represent the operations 
through which units or batches are followed. To identify the units or batches, they get 
a unique lot ID, which is stored with related process information in the database. 
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Related lot ID records in consecutive process stages are linked, which makes it possible 
to track and trace the path of units or batches through all the intermediate steps of the 
production flow. See CHAPTER 4. 

 

Additionally, quality characteristics can be inserted at critical control points for the 
batches represented by the lot IDs. Either automatically or manually, quality results on 
samples taken from the batches in a specific process stage are inserted into the 
database and linked to the lot ID record. This way, track and trace operations reveal 
the quality of the traced goods. See CHAPTER 5. 

To allow consistent and quick data entry, you.trace.it provides for base tables. Base 
tables contain reference data which identify records in process stages and quality 
controls. For example, to indicate the supplier of materials when inserting incoming 
batches. See CHAPTER 6. 

you.trace.it also includes: 

•  Qualifications to define limits for attributes. Non-compliant attribute values are 
highlighted. This way, you immediately notice which lot IDs meet the 
requirements of your customers. See CHAPTER 5. 

•  SQL and XML query builders to compare and exchange any data stored in the 
database. See CHAPTER 7. 

•  User security to assign access rights to users and user groups. See CHAPTER 8. 
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System requirements 

The following hardware and software is required to run you.trace.it: 

•  1 GB of random-access memory (RAM) 

•  250 MB of available drive space 

•  Local or network licence key  

•  Intel Pentium processor recommended 

•  Windows XP or later 

•  MS SQL Server 

•  Colour monitor with a screen resolution of 1024 by 768 pixels 

•  Microsoft Internet Explorer and Acrobat Reader. 

Pictogram usage 

This user’s guide uses the following pictograms to draw your attention: 

Image Description 

 Supplementary suggestions, advice or remarks, in order to enable you to
perform a task more easily or more quickly. 

 Cautions draw your attention to operations, which, if performed
incorrectly, could result in loss of data or undesired results. This, in turn,
would imply that you would have to repeat the operation in part or in full. 

 References point to related topics in this user’s guide. 
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What’s new 

New features in you.trace.it 3.0 are: 

•  Improved user interface. 

•  User security allows to assign user rights to users and user groups. 

•  When linking lot IDs, you can indicate the linked quantity. 

•  Process stage grid displays linked quality records in integrated quality grid. 

•  Origin & destination panels display parent and child lot ID records in consecutive process stages. 

•  Qualifications take the values of linked quality records into consideration when assessing lot ID 

records. 

•  Design & print quality reports. 

Regional settings 

you.trace.it takes into account some regional options of the local system.  

Check the settings under Control Panel, then open Regional Options. 

Decimals 

you.trace.it users must apply the decimal symbol (period or comma) when entering 

values in numeric fields in order to separate the integer part from the decimal part. 

Note that commas as decimal symbols can only be entered using the alphanumeric 

keyboard! Periods can be inserted using both the alpha- and numeric keyboard. 

Date & time 

Regional date/time options are taken into account for fields where a date and/or time 

is displayed. Depending on the DateTimePicker control’s settings, you may customise 

Short Date and Long Date formats in the system’s Regional Options. 

Input Locale 

you.trace.it does not take the Input Locale into account to determine the interaction 

language. Only standard buttons in message boxes (like Ok, Cancel, Yes, No) follow 

the Regional Language Options. See page 22. 

Quick guide 
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To make you familiar with the way you.trace.it handles traceability and quality records, 

we rely on the case study explained here. It involves a general production environment 

where different sorts of raw materials are bought in bulk. Those materials are turned 

into articles. The articles are packed in boxes and shipped to the customers on pallets.  

Reception (of raw materials) 

Lot ID records 

The product line consists of two articles, article 1 and 2. To produce those articles, 

three sorts of raw materials are bought from three different suppliers. Each delivery is 

registered by keeping a lot ID record for that batch of raw materials in the reception 

process stage.  

You see the grid listing the reception lot ID records in the database and the form to 

register new deliveries of raw materials: 
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The attributes Unit Abbreviation, Materials and Supplier must be selected from a scroll 
list. The data displayed in the scroll lists is retrieved from the corresponding base tables 
Unit, Materials and Supplier: 

 

Quality records 

To monitor product quality, we take a sample of each incoming delivery of raw 
materials. The stiffness of the materials is tested and a quality label is assigned to the 
batch.  

Again, you see the grid listing the quality record(s) for the selected lot ID and the form 
to insert the test results in the database: 
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Qualifications 

Customer quality requirements with regard to the used raw materials can be stored in 
qualifications. Our customers impose different limits regarding the stiffness percentage 
of used raw materials. This is the qualification for customer 2: 

 

When you activate that qualification to check whether quality records, and 
consequently lot IDs, comply with the requirements, non-compliant values are 
highlighted: 

 

Since the stiffness value in the example above amounts to 23 %, and the maximum 
upper limit is 18 %, the value is highlighted in the quality record. Compliant or non-
compliant lot IDs are shown by clicking  or  in the toolbar. 

Production (of articles) 

Lot ID records 

The composition of raw materials for both articles is explained in the table below: 

 
 

Raw Material 1 Raw Material 2 Raw Material 3 

Article 1 (15 boxes) 
1000 kgs 500 kgs - 

Article 2 (20 boxes) - 500 kgs 1500 kgs 
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A production lot ID record is inserted in the database for every operation of combining 
raw materials to produce articles. You see the grid listing the production lot ID records 
in the database and the form to register new ones: 

 

The Origin panel lists the reception lot ID records (raw materials) that were used to 

produce the selected production lot ID: 1000 kgs of raw material 1 and 500 kgs of raw 

material 2 yield 15 boxes of article 1. 

Quality records 

To monitor product quality, we take a sample of each batch of produced articles. The 
humidity of the articles is measured and a quality label is assigned to the batch.  

Again, you see the grid listing the quality record(s) for the selected lot ID and the form 
to insert the test results in the database: 

 

 The symbol to separate decimals in numeric fields depends on the regional 

options, period or comma. Note that commas as separators can only be entered 

using the alphanumeric keyboard! 
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The qualification for customer 2 contains a limit for the humidity value of the articles, 
which may not exceed 10 %. Since 5.9 % complies with the limit and results in a 
compliant production lot ID: 

 

Expedition (of pallets) 

Articles are shipped differently depending on the type: 

 
 

Boxes / Pallet 

Article 1 
30 boxes 

Article 2 40 boxes 

An expedition lot ID record is inserted in the database for every shipment of articles of 

a particular type to one customer. You see the grid listing the lot ID records in the 

database and the form to register new ones: 

 

The Origin panel lists the production lot IDs that were palletised. Article 1 is palletised 
per 30 boxes, which requires two batches of 15 boxes. 
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Tracking & Tracing 

To retrieve the path of a lot ID through the intermediate stages of the production flow, 
you use the track & trace commands. To trace the origin, i.e. the used raw materials, of 
expedition lot ID ’EXP11117000002’, click the trace back button in the Track & Trace 
toolbar: 

 

 

Expand the Lot Genealogy Tree to display the related lot IDs in consecutive process 
stages. Activate qualifications to learn whether lot IDs comply with quality 
requirements: 
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Installation 
 

Installing you.trace.it 

Proceed as follows to install you.trace.it: 

1  Close all other applications. 

2  Run setup.exe from the you.trace.it CD-ROM. 
- or - 
Click Install you.trace.it in the Autorun window. 
The you.trace.it installation wizard appears. 

3  Click Next >. 

4  Choose to accept the licence agreement and click Next >. 

5  Enter user name and organisation, then click Next >. 

6  Browse to the location where you.trace.it must be installed, then click Next >. 

7  Select Custom, click you.trace.it and select ’Will be installed on local hard drive’.  
Select ’Entire feature will be unavailable’ for programs you do not wish to 
install. 

 

1  Click Next > twice to begin the installation. 
Follow on-screen instructions. 
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Installing the licence server 

What is it 

The usage of you.trace.it is protected with licence keys. The licence key must be 
connected to the parallel/USB port of a workstation in your LAN. Without licence key, 
you can run you.trace.it for 30 minutes only. When you have a local licence key, you 
do not need to install the Licence Server. In case of a network licence key, the Licence 
Server is required to monitor licence usage in the LAN or to upgrade the key resources 
(clients & attributes). 

Installation 

Proceed as follows to install the licence server for you.trace.it: 

1  Close all other applications and make sure all hardware keys are disconnected from LPT1. 

2  Run setup.exe from the you.trace.it CD-ROM. 

3  Click Next >. 

4  Choose to accept the licence agreement and click Next >. 

5  Enter user name and organisation, then click Next >. 

6  Browse to the location where the features must be installed, then click Next >. 

7  Select Custom and click Next >. 

8  Click Licence Server and select ’Will be installed on local hard drive’.  

9  Click Next > twice to begin the installation. 

When the installation of the licence server is completed, the setup for the Sentinel 
System Driver is launched. The driver allows for communication between the licence 
key (connected to LPT1) and you.trace.it. 

1  Choose to accept the licence agreement and click Next >. 

2  Select Custom and click Next >. Then, click Parallel System Driver and select ’This 
feature will be installed on local hard drive’. To exclude the USB driver from the 
installation, click USB System Driver and select ’This feature will not be available’. 
Click Next >. 

3  Click Install to begin the installation. 
Follow on-screen instructions. 

4  Click Finish. 
Installation directory is Program Files\Rainbow Technologies\Sentinel system 
driver. 

5  Connect the licence key to the parallel/USB port of the server. 
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Installing SQL components 

Introduction 

you.trace.it requires an instance of SQL server installed locally or in your LAN.  
Check whether you must install SQL components from the you.trace.it CD-ROM. 

If ... Then ... 
SQL server 2000 or MSDE is available locally do not install MSDE or SQL-DMO. 
SQL server 2000 or MSDE is available in the 
network 

install SQL-DMO on the remote 
systems, which must connect to the
SQL server. 

No SQL server or MSDE is available install MSDE on a local system or server
install SQL-DMO on the systems, which 
must connect to the MSDE. 

Install SQL Server Desktop Engine (MSDE) 

 MSDE will not be installed on a computer that has an instance of SQL server 
running. 

The SQL Server Desktop Engine (MSDE) setup also includes SQL Server Client Objects 
(SQL-DMO). MSDE is a low-end alternative to SQL server and can be installed on a 
workstation or server. However, you must install SQL- DMO on all systems that need 
access to the MSDE. Proceed as follows to install MSDE: 

1  In the Autorun window, click Install SQL Server Components. 

2  Select Install Microsoft SQL Server Desktop Engine and click Install. 

 SQL Server Security is applied when installing MSDE.  
You need an ’sa account’ without password to access MSDE databases. 

Install SQL Server Client Objects (SQL-DMO) 

 SQL-DMO will not be installed on a computer that has an instance of SQL server 
running. 

SQL Server Client Objects (SQL-DMO) must be installed on systems which must connect 
to a remote database (SQL Server or MSDE). Proceed as follows to install SQL-DMO: 

1  In the Autorun window, click Install SQL Server Components. 

2  Select Install Microsoft SQL Server Client Objects and click Install. 

3  Click Next > to begin the installation. 
Follow on-screen instructions. 

4  Click Finish and restart Windows when requested. 
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Start & log on 

When you.trace.it is launched, the program automatically connects to the database to 
which it was connected when the program was shut down. Proceed as follows to 
connect to a database and log on: 

1  Launch you.trace.it by choosing Programs > you.integreat.it > you.trace.it in the Start menu. 

When used for the first time or when the database is offline, the database connection window 
appears on start- up: 

  
If you want to connect to another database when you.trace.it is started, point 
to Application>Settings. 

2  Select the SQL server in the network or type ’(local)’ when the user database is stored in an 
instance of SQL server run by the same computer that runs you.trace.it.  

3  Select the login method for the SQL server: Windows NT integrated security (user name and 
password to connect your PC to the LAN is used) or specific user name and password for the 
SQL server (’sa’ account).  
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4  Select a database and click OK to connect. 
The log on window pops up: 

5  Enter the user name and password of your personal network account.  
Also specify the Windows domain, if required. 

 Depending on the user rights assigned to the logon account, actions can 
be performed and classes can be accessed. Contact your system 
administrator if you do not have sufficient user rights. Refer to “About 
user rights” on page 81 for more details on assigning user rights in 
you.trace.it. 
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Work area 

The you.trace.it work area is shown here: 

 

Numbered items are explained below: 

1  Toolbars for the most common actions in you.trace.it. 

2  The grid displays the records stored in the corresponding database table. 

3  The calendar allows to search data records by date. 

4  The origin and destination panels display parent and/or child lot ID records and used quantities. 

5  The secondary grid displays quality records linked to the selected lot ID record. 

6  The folder list provides a tree view from where you can access all database tables. 

7  All the database tables opened in the grid (1) are available in different tabs. 
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Navigation 

you.trace.it is intended to manage traceability and quality records in a database. The 
database contains tables of different kinds and you can open them from the folder list: 

 

 

Groups See 

Process Stages CHAPTER 4 

Quality Controls CHAPTER 5 

Base Tables CHAPTER 6 

Qualifications CHAPTER 5 

Queries CHAPTER 7 

User Rights CHAPTER 8 
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Toolbars 

Show or hide toolbars by right-clicking in the menu area (or View>Toolbars).  

You can also show or hide the calendar (3), the origin and destination panels (4) and 

the quality grid (5). 

The availability of toolbars depends on the selected type of table. 

 

Standard toolbar 

create record

edit record

print & preview
records

cut, copy, paste

export grid to HTML, Excel, 
ASCII, PivotT able, XML

find data

refresh grid (F5)

Date Filter toolbar 

The Date Filter toolbar is used in combination with the Calendar to filter records in the 
grid by date (see page 24).  

only records on day selected in
Calendar

only records
with today’s date

only records in week 
selected in Calendar

only records in month selected 
in Calendar

all records



 you.trace.it user’s guide |Geert Vanoverschelde 21

Track & Trace toolbar 

The Track & Trace toolbar is available for tables containing lot IDs. You can track and 
trace the path of a unit or batch through the intermediate stages of the production 
flow (see page 46). 

 

Qualifications toolbar 

The Qualifications toolbar becomes available when you select tables that contain 
records with attributes for which limits have been defined (see page 59).  

Quality toolbar 

The Quality toolbar is used to insert or edit quality records (see page 54).  

track destination of lot ID
(forward)

trace origin of lot ID
(backward)

process stage selection for trace 
till command

trace path of lot ID till specific 
process stage

list of available qualifications

show compliant records only 
(process stages only)

show non-compliant records only 
(process stages only)

edit quality record

create quality record quality type scroll list

refresh quality grid
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Language settings 

The default interface language for you.trace.it is English. If the database, to which you 
are connected, supports multiple languages, you can change the user interface 
language in the View menu.  

Point to Select Languages, then click the language you prefer.  

 If interface items seem to be missing or appear in another language, contact your 
integrator. The corresponding language files (*.igl) may need to be adjusted and 
the database must be upgraded! 
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CHAPTER 3 

Record & Grid Basics 

Record & Grid Basics teaches you how to filter, find, 
search, sort and format lot ID and quality records. 
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Filtering records 

You can filter grids to limit the displayed number of records: 

•  by date 

•  by contents. 

Filter records by date 

The Date Filter toolbar is used in combination with the Calendar to filter records by 
date.  
Proceed as follows to filter data records by date, week or month: 

1  Select a date, week or month in the calendar: 

 

1  Select the filter method in the Date Filter toolbar: 

 

 If the calendar is not displayed in the correct language, change the locale of your 
PC. Click the Start menu and go to Settings > Control Panel > Regional Options and 
select your locale on the General tab. 

click and hold to change month

go to previous month go to next month

select date

only records on day selected in
Calendar

only records
with today’s date

only records in week 
selected in Calendar

only records in month selected 
in Calendar

all records
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Filter records by contents 

Content filters allow you to specify data, according to which the grid is filtered. You 
can use the filter bar (simple queries) or an advanced filter (complex queries).  

Filter bar 

Proceed as follows to activate and use the filter bar: 

1  Right-click the grid and point to Extra > Filter > Filter bar. 
An empty row appears under the header: 

 
2  Place the cursor in an empty cell and enter data. 

The grid only displays the records that match the data: 

 
3  To hide the filter bar, right-click the table, and select Extra > Filter > Filter bar. 

Example: You only want to view the records of specific date. 
Activate the filter bar, put the cursor in the empty cell in the column.  
Click the arrow to specify the date or period (a ’From’ and ’To’ date). 
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Advanced filter 

Proceed as follows to use the advanced filter: 

1  Right-click the grid and point to Extra > Filter > Advanced Filter: 

 

2  Select the column to be filtered. 

3  Select a logical operator (>, <, =, <>) and enter a value. 

4  Select ’and’ or ’or’ in the Operator column, if you want to add another search string. 

5  Click OK to filter the grid: 

 
6  To reset filters, right-click the grid and point to Extra>Filter>Reset All Filters. 

Example:  You only want to view the records registered before the 17th of December 2003 by 
Supplier 1. Specify that the value in the Begin Time column must be ’<’ than 17/12/2003. Select ’And’ in 
the Operator column and specify that the Supplier column must contain Supplier 1. 

Operators: Most operators are obvious, though: ’<>’ means different from; ’Between’ allows to 
specify a range and ’Like’ allows to specify parts of fields (e.g. Sup* displays records beginning with 
’Sup’). 
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Finding data in records 

If you are looking for specific data in records, use the Find function.  

Proceed as follows: 

1  Click  in the toolbar: 

 

1  Select the column to be searched. 

2  Enter the data to be found. 

3  Specify the search direction and the start position, if needed. 

 The start position relates to the place in the table where you want to begin 
your search (current position, begin or end). The search direction refers to 
the direction the table will be searched (up, down or all). 

4  Tick Find whole word only to search for the whole word (parts are ignored). 

5  Click Find next to find matches. 
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Sorting records 

Sort records (easy) 

Proceed as follows to sort records by means of a head click: 

1  Right-click the grid and point to Extra > Sort > Sort on Head Click. 

2  Click the header of the column according to which you want to sort the grid. 

3  Click again to restore the original order. 

Sort records (advanced) 

Proceed as follows to use the advanced sorting method: 

1  Right-click the grid and point to Extra > Sort > Advanced Sort. 

 

2  Select a primary sort key in the Sort By scroll list and select Ascending or Descending. The sort 
key is the column, according to which you want to sort the grid. 

3  To specify a second or third sort key, select a sort key in the second or third Then By area. 

4  Click OK. 
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Formatting grids 

If you adjust the way records are displayed in a grid, your preferences are saved in 
layout files in the following directory: Documents and Settings\[Your Account 
Name]\Application Data\you.integreat.it\Trace_It_Layout. 
 

To restore default settings, delete the files. You can customise the grid by: 

•  showing / hiding columns 

•  changing the order of columns 

•  changing the table view 

•  changing grid properties (colour, font, etc.). 

Show / hide columns 

To hide columns in the grid, proceed as follows: 

1  Right-click the grid and point to Extra > Show / Hide Columns or click the Show / Hide 
Columns button on the Standard toolbar. 

 This window not only lists the columns in the table itself, but  

also the columns in the linked base tables. 

2  Clear the check boxes to hide the corresponding columns. 

 To hide all columns, clear the check box 
in the bottom-left corner. 

3  Drag and drop column names to change the order of appearance. 

4  Click OK. 
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Different table views 

The way the grid is displayed can be changed.  
Right-click the grid and point to Extra > Table View. 

•  Normal View: 

 

•  Group View: 

  

•  Inverted / Form View (columns become rows and vice versa): 

 

area to group rows by the
contents in a particular

column, see page 36

view next record using horizontal scrollbar
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Change column order 

You can drag columns to the left or right in the grid.  
Proceed as follows to change the order of columns in grid: 

1  Hold Shift and click the headers of the column(s) you want to move. 

  

2  Drag and drop the column(s) to another location in the header. 

 

The column order is changed: 
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Group rows by contents 

The Group View allows to group rows according to their contents. You select the 
column header and drag it into the area above the grid. Proceed as follows: 

1  Right-click the grid and point to Extra > Table View > Group View. 

2  Select the column by clicking its header. 

 

3  Drag and drop the column header into the group area above. 

 

The grid is grouped according to the contents of that column: 

 

4  Drag and drop other column headers. 

 

5  Restore the grid by dragging and dropping column headers in the grid. 
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Change grid properties 

Right-click the grid and point to Extra>Settings to change grid settings: 

•  Alternating row style 

•  Row height 

•  Grid ruling colour 

•  Table view 

•  Text style. 

This is the tab where you can adjust grid settings: 

 

1  Alternating row style allows to display odd an even rows in a different colour. Select the colour 
for the even rows from the scroll list. Turn off by selecting white colour! 

2  Row height specifies the height of one record (in twips). 

3  MaxRows specifies the maximum number of rows in a table. 

4  Row divider specifies the colour of the row and column ruling in grids. 

5  Table view allows to change the way the grid is displayed. See page 30. 

6  Click the Font Settings tab to change the font, size and effects for text in the data records. 
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Exporting records 

To export the records in a grid, click the corresponding button in the Standard toolbar: 

 

Grids can be exported to the following formats: 

Format Description 

HTML *.htm file to display data in a web browser 

XML *.xml file to interchange structured data over the internet 

ASCII *.txt file to present data in basic text format 

MS Excel *.xls file to analyse and compare data 

PivotTable format to generate graphical, interactive reports for data analysis 

 

MS Excel

ASCII

HTML

PivotTable

XML
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CHAPTER 4 

Process Stages & Lot IDs 

This chapter informs you on process stages and lot ID 
records. Every lot ID relates to a particular operation 
in the production process. What are lot IDs, how do 
you insert lot ID records and link related ones in 
consecutive process stages?  

You will also learn how to trace the origin or track 
the destination of lot IDs through the intermediate 
process stages.  
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Introduction 

Process stages 

Primarily, you.trace.it is meant to insert lot ID records in the database. Every record 
uniquely identifies a unit or batch as it is being transformed in a production flow. 
Process stages represent the major operations in that production flow.  

For each unit or batch undergoing such operation, a lot ID record is inserted into the 
database, along with relevant process data. The practical case used in this user’s guide 
is explained briefly in the table below: 

Process stages Reception Production Expedition 
Operation Registration of 

incoming raw 
materials 

Registration of 
every production 
run to turn raw 
materials into 
articles 

Registration of 
every shipment of 
articles to 
customers 

Logical sequence 1 2 3 
Unit Bulk (kgs) Boxes (Bxs) Pallets (Plts) 
Lot ID prefix REC PRD EXP 
Linked quality control QA_Reception QA_Production None 

Record registration 

For each unit or batch in a process stage, a lot ID record is inserted into the database. 

It tells you all about the features of a unit or batch at that stage of production. See 

page  39. 

Record linking 

Related lot ID records for a unit or batch in consecutive process stages are linked to 

one another in the database, which makes it possible to follow and trace the path of 

articles through all the intermediate steps of a production flow. See page  40. 
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Process stage grids 

Lot IDs are organised per operation in a production flow, i. e. per process stage. You 

can consult the inserted records for a process stage by opening its grid, which displays 

the contents of the corresponding table in the database. An example of a process 

stage grid is shown below: 

 

1  Overview of the available process stages. 

2  Grid listing the inserted lot ID records for the selected process stage. 

3  Grid listing the inserted quality records for the selected lot ID record. 
Only available for process stages with related quality control. 

4  Origin and destination panels display parent and/or child lot ID records and used quantities. 
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Lot ID records 

Sometimes you.trace.it is configured for automatic data exchange with automated 
production equipment. In such cases, lot ID records may be inserted in the database 
and linked to related ones in consecutive process stages automatically. However, lot ID 
records can also be inserted and linked manually. 

Lot IDs & attributes 

A lot ID record is kept for every unit or batch undergoing an operation in a process 
stage. This record lists the attributes of the batch, which is the information with regard 
to the operation performed in that stage of the production flow. An example of lot ID 
records: 

 

When a record is inserted, you.trace.it assigns a unique lot ID that uniquely identifies 
the unit or batch.  

The format of lot IDs is identical for all process stages: 

 

The process stage abbreviation is a three-letter indicator of the process stage to which 
the lot ID record belongs. Some examples:  

•  REC for reception 

•  PRD for production 

•  WAR for warehousing 

•  EXP for expedition.  

The other bits of information stored in the lot ID record are the attributes or features of 
the unit or batch in that process stage: registration time of the lot ID, produced 
quantity, unit of measurement, the line on which article was manufactured, type of 
produced article, etc. 
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Insert lot ID records 

In order to insert lot ID records for process stages, you must input the information in 
you.trace.it.  

Proceed as follows to insert lot ID records for units or batches: 

1  Open the Process Stages folder in the folder list. 

2  Click the process stage to which you want to add a lot ID record. 

3  Click  in the toolbar. 

The form for that process stage appears: 

 
4  Specify begin and/or end times, which indicate when the operation for that unit or batch was 

started or finished in the corresponding process stage. 

5  Enter data or select it from the scroll lists. 
Required information is indicated by red asterisks. 

6  Click OK to insert the lot ID record in the database. 

 To edit the lot ID record later, select it and click  in the toolbar. 
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Link lot IDs 

Why 

When raw materials are transformed into articles, a lot ID record is stored in the 
database for every operation the raw materials undergo. If you want to learn about the 
destination of the raw materials or the origin of produced articles, the related lot ID 
records in the consecutive process stages must be linked to each other. 

Example 

When raw materials are taken into production, a PRD lot ID is inserted in the database 
and linked to the reception lot ID record(s) from which raw materials were taken to 
produce the PRD lot ID.  

You can link lot IDs in two different ways: 

If ... Then ... See 

the lot ID does not yet exist in the 
target process stage 

create lot ID and link it to the 
related lot ID(s) in the preceding 
process stage 

page  41 

the lot ID already exists in the 
target process stage 

drag & drop related lot IDs to 
establish link 

page  43 
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Create new lot ID and link 

Proceed as follows to insert new lot IDs in target process stages while linking: 

1  Right-click the lot ID record and point to Link. 

Hold the Ctrl key to select multiple records. 

2  Select New Lot and point to the target process stage: 

 
3  The form for the target process stage appears. Complete the fields and click OK. 

The Quantity Specification window pops up: 

 
4  In the Quantity box, enter the number of units from the source lot ID that are used in the target 

lot ID. Click OK. 
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5  Test the link by performing trace forward on source lot ID: 

 
The Lot Genealogy Tree shows the relationship between both lot IDs: 
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Link to existing lot ID 

Proceed as follows to link lot IDs to existing lot IDs in consecutive process stages: 

1  Right-click the lot ID record and point to Link. 
Hold the Ctrl key to select multiple records. 

2  Select Existing Lot and point to the target process stage: 

 
3  The grid of the target process stage appears: 
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4  Drag and drop the source lot ID onto the target lot ID: 

 

 The direction of dragging and dropping the lot ID records (source to target 
or target to source) does not matter since you.trace.it takes into account the 
logical sequence of process stages. 

The Link Detail window pops up to specify linked lot quantities: 

 
5  In the Quantity box, enter the number of units from the source lot ID that are used in the target 

lot ID. Click OK. 
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6  Test the link by performing trace back on target lot ID: 

 

 

The Lot Genealogy Tree shows the relationship between both lot IDs: 
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Tracking & tracing lot IDs 

Lot Genealogy Tree 

Thanks to the link between related lot IDs in consecutive process stages, you can trace 
the path of raw materials, half-finished products or articles through the intermediate 
process stages. You have several options for tracking and tracing the production path 
of lot IDs: 

•  trace the origin of lot ID records (trace back) 

•  track the destination of lot ID records (trace forward) 

•  track or trace related lot ID records in a target process stage (trace till) 

•  combine track and trace options for recalls. 

 Refer to “Track & Trace toolbar” on page 21 for details on the Track & Trace 

toolbar. 

Results of tracking and tracing lot IDs are displayed in the Lot Genealogy Tree: 

 

1  Lot Genealogy Tree displays related lot IDs in consecutive process stages. 

2  Attribute values of selected lot ID in Lot Genealogy Tree. 
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3  The destination and origin panels display parent and/or child lot ID records. 

4  Quality Controls tab: Related quality control records for selected lot ID in Lot Genealogy Tree, if 
available. 

Trace Till tab: Displays related lot IDs in process stage selected from drop-down list. 

Trace backward 

The trace backward command shows the related lot IDs in all process stages, prior to 
the stage to which the selected lot ID belongs. The expanded Lot Genealogy Tree lists 
the lot IDs from which the selected lot ID originates, up to the initial process stage, i. e. 
where the raw materials were registered in the database. 

1  Select the lot ID of which you want to trace the origin. 

2  Click  in the Track & Trace toolbar and expand the Lot Genealogy Tree. 

The related lot IDs in the preceding process stages are listed: 

 
3  Select a lot ID in the Lot Genealogy Tree, then click the Quality Controls tab to view related 

quality control records. 

 



 you.trace.it user’s guide |Geert Vanoverschelde 48

Trace forward 

The trace forward command shows the related lot IDs in all process stages, subsequent 
to the stage to which the selected lot ID belongs. The expanded Lot Genealogy Tree 
lists the lot IDs into which the source lot ID was transformed during the following 
process stages up to its final destination, i.e. the last process stage where the articles 
are shipped to customers. 

1  Select the lot ID of which you want to track the destination. 

2  Click  in the Track & Trace toolbar and expand the Lot Genealogy Tree. 
The related lot IDs in subsequent process stages are listed: 

 
3  Select a lot ID in the Lot Genealogy Tree, then click the Quality tab to view related quality 

records. 
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Trace till 

Trace till operations show a list of related lot ID records in the selected target process 
stage. 

1  Select the lot ID record to be tracked or traced. 

2  Select the target process stage in the Track & Trace toolbar. 

3  Click  in the Track & Trace toolbar. 
The related lot ID records in that process stage are listed: 

 
- or - 

You can also get an overview of related lot IDs in a target process stage from 
within the Lot Genealogy Tree window. Select the Trace Till tab, and point to 
the process stage in the drop-down list: 

 
The related lot IDs are listed in the Trace Till grid. 
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Recall lot IDs 

To recall contaminated articles from the supply chain, you must: 

•  find out the lot ID(s) to which the contaminated articles belong. 

•  find the related lot IDs in the initial process stage (raw materials). 
check quality characteristics of traced lot IDs using qualifications. 

•  find any lot IDs that originate from the possibly contaminated lot IDs in the initial process stage. 

Proceed as follows to determine lot IDs that may be related to contaminated articles: 

1  Select the lot ID to which the contaminated article(s) belong, and of which you want to trace the 
origin. 

2  Click  in the Track & Trace toolbar. 
The related lot IDs in preceding process stages are listed: 

 
Check quality characteristics of the traced lot IDs using qualifications. See “Qualifications in Log 
Genealogy Tree” on page 53. 
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3  Expand the Lot Genealogy Tree up to the lot ID(s) in the initial process stage. Then, highlight one 
of the reception lot IDs, click the Trace Till tab and select the process stage from the scroll list 
(usually final stage - Expedition): 

 
The expedition lot ID records that are directly or indirectly related to the selected 
reception lot ID, are listed in the Trace Till grid. 

4  Create a shortlist of all related, and possibly contaminated, lot IDs. 
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Archived lot IDs in Lot Genealogy Tree 

Since lot IDs are archived and cleared from the database at regular intervals, you may 
find that part of the lot ID’s genealogy is missing. However, a reference to the 
respective archive indicates where you can find the rest of the lot ID’s genealogy:  

 

Identifying fields in Lot Genealogy Tree 

Lot genealogies may not display lot IDs in the tree view because the process stage to 
which the lot ID belongs has an identifying field other than the lot ID, which is the 
default identifying field for process stages. 

 

To switch between identifying fields and lot IDs, click the Toggle ID Fields button in the 
toolbar.  
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Qualifications in Lot Genealogy Tree 

It is important that you can quickly determine whether lot IDs in the Lot Genealogy 
Tree meet particular quality requirements, e.g. imposed by customers. With 
qualifications, you can define limits for the values that must be checked. See 
“Qualifications” on page 59 for more information on creating and applying 
qualifications.  

You can check whether records in a grid meet the limits in a qualification, but also in a 
Lot Genealogy Tree. 

Proceed as follows to apply qualifications in a Lot Genealogy Tree: 

1  Select the lot ID in the Lot Genealogy Tree to check whether its lot ID or quality values meet the 
limits in the qualification. 

 
2  Select the qualification to be applied from the scroll list in the toolbar. 

In the example above, the quality record linked to the PRD lot ID contains an attribute 
’Humidity’. Since the limit for the attribute determines that its value may not exceed 5 %, the 
field is highlighted. 

3  Click  or  to indicate compliant or non-compliant lot IDs in the tree. 
Because the attribute value does not comply with the limit, the corresponding 
lot ID is considered non-compliant with the requirements for that qualification. 
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CHAPTER 5 

Quality Controls & 
Qualifications 

This chapter informs you on how to manage product 
quality with you.trace.it. You learn how to insert and 
retrieve quality records for lot ID records.  

Furthermore, you will be taught how to define 
qualifications, i.e. collections of limits for attributes 
of lot IDs and quality records. This way, you can 
check whether lot IDs (and related quality records) 
comply with the quality requirements of your 
customers.  
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Introduction 

Quality records 

Quality controls are available for critical control points in the production flow. Provided 
that a quality control is linked to a process stage, quality characteristics of lot IDs can 
be kept in quality records.  

•  This may involve quality tests on samples taken from batches of raw materials or half-finished 
products. Results can be inserted in the database using the available forms.  

•  On the other hand, quality records may be inserted automatically when they involve real-time 
process monitoring of critical machine parameters (temperatures, defects, stops).  

Record registration 

A sample is taken from a batch of products and checked. The results of the quality 
control are inserted into the database by filling in the fields on a form. See page 58. 

 You can only insert quality records for lot IDs when a quality control is related to 

that process stage. The process stage window features a secondary quality grid. 

See page 37. 

Record linking 

Quality records are linked to the selected lot ID record or to the active lot ID in the 
process stage in case of automatic registration. Finally, quality controls yield valuable 
quality information on tracked or traced lot IDs because quality records related to lot 
IDs are displayed in the Lot Genealogy Tree. 

Qualifications 

In grids and Lot Genealogy Trees, you can check whether the values and quality 
characteristics of traced lot IDs (and related quality records) meet customer 
requirements by applying the corresponding qualification. Non-compliant lot IDs can 
be highlighted. See “Applying qualifications to records “Applying qualifications to 
records” on page 63 for more information. 
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Quality control grids 

Process stage window 

Quality records must always be linked to a lot ID record. That is why you must always 
select a lot ID record first, before you can insert quality records into the database! If a 
quality control is related to a process stage, the grid of that process stage is split 
horizontally. The upper grid lists the lot ID records. When you select lot ID records, 
linked quality records are displayed in the lower half. 

The quality grid in process stage windows allows to insert quality records: 

 

1  Lot ID records in table of opened process stage. 

2  Quality toolbar allows to select type of quality control if more than one type of quality control is 
available for the process stage; see page 21. 

3  Linked quality records for selected lot ID. 
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Quality control window 

The quality control window lists all quality records of a particular type. You cannot 
insert records, but you can check whether quality records meet qualification 
requirements or not: 

 

When attribute values do not comply with the limits in the active qualification, the 
quality record is highlighted. Refer to “Applying qualifications to records” on page 63 
for details. 
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Quality records 

Quality records & attributes 

A quality record can be kept for every type of quality test performed on lot IDs. This 
record contains the test results or the values of the real-time quality control. An 
example: 

 

Insert quality records 

Proceed as follows to insert a quality record for a lot ID: 

1  Open the process stage folder and select the lot ID for which you want to insert quality data. 

2  If multiple quality controls are available for a process stage, select the type of quality record you 
want to add from the Quality toolbar. 

3  Click  in the Quality toolbar. 
- or - 
Drag and drop the lot ID record into the Quality grid. 
The form for the quality control appears: 

 
4  Specify the inspection date. 

5  Enter data or select it from the scroll lists. 
Required information is indicated by red asterisks. 

6  Click OK to save the quality record. 

 To edit the quality record, select it and click  in the toolbar. 
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Qualifications 

What 

Customer quality requirements may vary and it is important that you can check 
whether or not the characteristics of lot IDs comply with the customer’s demand. In 
you.trace.it, you can create qualifications, which are a collection of limits for the 
attributes of records in the database. So, for every characteristic that is important to 
your customers, and stored in a data record, you can set a minimum and/or maximum 
value per customer. By activating a qualification, records in the grid that contain non-
compliant values, are highlighted. 

Example 

Our customers impose different limits regarding the stiffness percentage of used raw 
materials.  

This is the qualification for customer 2, containing two limits. A limit is created for the 
stiffness percentage, which is an attribute of the class QA_Reception (a quality control): 

 

When you activate that qualification to check whether quality records, and 
consequently lot IDs, comply with the requirements, non-compliant values are 
highlighted: 
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Since the stiffness value in the example above amounts to 23 %, and the maximum 
upper limit is 18 %, the value is highlighted in the quality record and non-compliant lot 
IDs are shown by clicking  in the Qualifications toolbar. 

Qualifications grid 

The qualifications grid lists available qualifications. The only way to edit existing 
qualifications is by right-clicking a qualification in the grid and pointing to Edit to 
change or add limits: 

 

Qualifications contain limits for every attribute that must be ’qualified’, i.e. checked 
whether the value of the attribute complies with the minimum and/or maximum 
value(s). You get an overview of the limits in a qualification by clicking the qualification 
in the folder list: 
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Creating qualifications and limits 

You can create limits for attributes of lot ID, quality or base records. Since quality 
records are always related to a lot ID, the attributes of the linked quality records are 
also taken into account to assess whether a lot ID is compliant or not! 

Proceed as follows to create a new qualification and limits: 

1  Click  in the toolbar of the qualification grid. 

The qualification form appears: 

 
2  Enter a name for the qualification, e.g. customer name. 

3  Select a colour to highlight non-compliant and/or alert values in records. 

4  Right-click the Limits grid and point to New Limit: 

 
5  Select the process stage, quality control or base table from the Class scroll list. 

6  Select the attribute. 

7  Enter the minimum and/or maximum values. 
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8  Click OK. 
The limit is added to the qualification: 

 
1  Click OK to save the qualification. 

2  To activate qualifications in order to assess lot IDs, refer to “Applying qualifications to records” 
on page 63. 

Remarks 

•  In our example, we created a limit for the Stiffness attribute in the quality control QA_Reception. 
Based on the Stiffness attribute, the user selects the Quality attribute from a scroll list. The 
values in that scroll list are AA, A, B and BB. 23 % matches B quality. However, we cannot put a 
limit on the Quality attribute, since its values come from a base table. Hence, you cannot select 
the Quality attribute from the Attribute scroll list in the Limit Specification window. 

•  Enter identical min. and max. values if attribute values must be equal to a specific value. 

•  For check boxes, the values are -1 (ticked) and 0 (not ticked). 
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Applying qualifications to records 

Usually, there will be different qualifications for different customers: qualification 1 
contains the limits of customer 1, while qualification 2 contains the quality 
requirements of customer 2. You can select the qualification to be applied to process 
stages and quality controls in the Qualifications toolbar. 

Qualifications assess the values for which limits were created. When they are applied to 
process stages, lot ID records are also assessed based on the values in linked quality 
records. 

 Performance may be low when you apply qualifications to  

grids containing a lot of records. 

Proceed as follows to apply qualifications: 

1  Open the process stage or quality control grid: 

 
2  Select the qualification to be applied from the Qualifications toolbar. 

 If there are no qualifications, or if existing qualifications do not contain 
limits for attributes in that process stage or quality control, selection is not 
possible. 
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Non-compliant values are highlighted: 

 
1  [Only for process stages] Click  or  to highlight the lot ID records in the grid that 

comply (green) or do not comply (red) with the qualification limits. 

 
2  Turn off the qualification by selecting None or by clicking the compliant / non-

compliant buttons again in the Qualifications toolbar.  
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Editing limits and consulting limit history 

Create new version 

If you change limits in a qualification, a new version of that qualification is created. The 
settings of the old qualification are logged. Proceed as follows to change qualifications 
and limits: 

1  Right-click the qualification in the grid and point to Edit: 

 

2  Double-click the limit, of which you want to change the settings. 
- or - 
Right-click the Limits grid and point to New Limit to add a limit. 

3  New Limit or Edit Limit brings up the following message: 

 

4  Click Yes. A new version for the qualification is added. 

 

 The current set of limits for the qualification features no end time. 
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Disabling qualifications 

Proceed as follows to disable / enable qualifications: 

1  Right-click the qualification in the grid and point to Disable: 

 
The icon turns grey and the qualification can no longer be used. 

2  To enable, right-click the disabled qualification and point to Enable. 

 
A new version of the qualification is created. 
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CHAPTER 6 

Base Tables 

This chapter makes you familiar with base tables. 
Base tables contain basic data records that are used 
to identify lot ID and quality records. Examples are 
lists of customers, suppliers, employees, quality 
labels, units, storage locations, etc. These data often 
appear in scroll lists on forms to insert lot IDs and 
quality records in the database. 
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Introduction 

Base tables contain referential information to describe lot IDs and quality records. 
When you insert lot ID records for a process stage ’Reception’ into the database, you 
can select the supplier of the raw materials from a scroll list on the form for the 
process stage ’Reception’. The names in that list are taken from the base table 
’Supplier’, which allows to register raw material suppliers. 
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Base table grids 

The base table grid allows to insert referential data into the database to describe lot 
IDs and quality records: 

 

1  Overview of available base tables. 

2  The base table grid displays the records in the selected base table. 
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Base table records 

Base records & attributes 

A record is kept for every item that is added to a base table. The records are displayed 
in the grid and may consist of several attributes. An example: 

 

Insert records 

Proceed as follows to insert records in base tables: 

1  Open the base table of your choice. 

2  Click  in the toolbar of the grid. 
The form for the base table appears. 

1  Enter data or select it from scroll lists. 
Required information is indicated by red asterisks. 

2  Click OK to save the record. 

 To edit the record, select it and click  in the toolbar. 
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CHAPTER 7 

Queries  

SQL Queries allow to analyse and compare any data 
stored in the database. This chapter makes you 
familiar with using the query builder.  
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About queries 

What 

SQL queries make it possible to analyse and compare the data that are stored in the 
database, according to your criteria. 

Example SQL query 

You want to generate a report that lists the quality and quantity of raw materials 
delivered by all of your suppliers. Proceed as follows to build the query: 

1  Since the quantity and quality of incoming materials are registered in different records, you have 
to link the tables in a query to bring the corresponding data together. Select the tables from the 
database and tick the check boxes of the attributes needed in the report. Since the OID attribute 
of a record is used to refer to data in other tables, you must link the OID attributes of referred 
tables to the counterparts in the referring tables: 

 

2  The query design in the grid pane looks as follows after selecting and linking the tables and 
attributes: 
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3  Add the Group By column to insert functions, set the sort order and include aliases, if required: 

 
4  Click  in the toolbar to execute the query: 

 

5  Save the query and the results are updated every time you consult it in the grid: 

 
6  Export the grid to HTML, MS Excel, ASCII, PivotTable or XML to generate reports or create 

graphical representations. 
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SQL Queries 

Query builder 

The SQL query builder allows to create statistics and reports by questioning the 
database. SQL queries are made in the SQL query builder. Proceed as follows to open 
the SQL query builder: 

•  Click  in the toolbar and point to SQL Query. 
The SQL query builder consists of four major parts: 

 

 The SQL query builder is similar to the Microsoft Access Query Builder.  

Also refer to the section on Working with Queries in Microsoft Access online Help. 

This is the SQL query builder toolbar: 

save query

query properties

SQL pane

result pane

execute query

diagram pane

verify syntax

group by

grid pane

tables window

 

diagram pane to select & link tables 
and attributes

grid pane to design query: 
sort order, criteria, fields

SQL pane displays SQL code

result pane displays results of query 
after execution
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Add tables and fields 

You must select the tables and fields in the database that contain the data you want to 
view, set criteria on, group by, update or sort. Tables and fields can be selected in the 
Tables window and are displayed in the diagram pane. Proceed as follows to select 
tables and fields that contain the data you want to work with: 

1  Click  in the toolbar. 
The Tables window pops up: 

 

2  Select the Tables tab and double-click the tables that contain the data you need in 
your query. 

They appear in the diagram pane. 

 

 To remove a table, select it in the diagram pane and press Delete. 
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3 Select the attributes to be used in your query by ticking the check boxes.  

The fields appear in the grid pane. 

 
The grid pane consists of the following columns: 

Columns Description 

Column Selected column/attribute in the table 

Alias Distinctive description for attribute 

Table Table that contains the attribute 

Output Enable / disable output 

Sort Type Ascending - Descending - Unsorted 

Sort Order 1 - 2 - etc. - Unsorted 

Group By Clauses or aggregate functions assigned to field 

Criteria Restrictions on a query 

Or... Specify ’Or’ conditions 
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Link attributes 

To bring data from different tables together, attributes must be linked by a join line in 

the diagram pane. Select an attribute [1], then drag & drop it onto the related attribute 

in the referred table [2].  

A join line appears between both [3]: 

 

 To remove a join line between tables, click it and press Delete. 

Set criteria to select specific data 

Criteria are restrictions on a query to identify the specific records you want to work 
with. For example, you can only show the quantities of quality A delivered by all of 
your suppliers. To specify criteria, select the Where clause in the Group By column and 
enter the expression in the Criteria cell for that field: 

You can use comparison operators such as ’equal’ (=), ’less than’ (<), ’less than or equal 
to’ (<=), ’greater than’ (>), etc. You can also enter additional criteria by adding And/Or 
operators. By using the And operator in a criteria cell only the records that meet all 
specified criteria will be returned. The Or operator will return records that meet at least 
one of the specified criteria. 

 Use the Or... column to specify Or conditions. You do not need to specify the Or 

operator in the corresponding filter cell. And conditions must be inserted in the 

Criteria column. 

Criteria are placed after the comparison operator and put in quotation marks 
automatically. Criteria must be linked to a Where clause in the Group By column. 
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You can also use the Expression builder to specify criteria expressions: click  in the 
toolbar. 

expression box

parameter names
and values for selected 
building blocks

expression
building blocks

 

 

Perform calculations 

You can perform calculations on fields by specifying a function in the Group By 
column: 

Function Description 

Count (distinct) Returns the total number of values. 

Sum Returns the sum of the numeric values. 

Max (distinct) Returns the largest value. 

Min (distinct) Returns the smallest value. 

Average Returns the average value. 

 The keyword ’distinct’ eliminates duplicate values before a function is applied. 
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Execute queries 

The result pane displays the result of the query after execution. 
Proceed as follows to execute queries: 

•  Click  to execute the query. 
The query result is displayed: 

 

Save queries 

Proceed as follows to save SQL queries: 

1  Click . 

1  Enter a distinctive name for the query. 

2  Click OK to save. 
The query is added to the query overview. 

Edit queries 

Proceed as follows to open an SQL query: 

1  Select Queries in the folder list. 

2  Select the SQL query in the grid to the right. 

3  Click  in the toolbar. 
The query is opened in the SQL query builder. 
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CHAPTER 8 

User Rights 

You can assign folder access rights to individual users 
of you.trace.it or to user groups. 
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About user rights 

The User Rights folder in you.trace.it allows administrators to assign user rights to users 
or user groups so that they can perform particular actions or access classes. Default, 
’Everyone’ is assigned to all classes and actions!  

 

If users may not have access to particular classes or may not perform particular actions, 
you must remove ’Everyone’ from the corresponding user right instance. Log on to the 
database as an administrator and remove ’Everyone’ by clicking . Then, add the users 
or groups that may access the class or action. 
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Actions and folders 

You can assign rights for the following pre-defined actions or folders in you.trace.it: 

Item Description 
Classes Grant rights to add and edit records in process stages, quality

controls and base tables. 
Qualifications Grant rights to create and edit qualifications. 
Queries Grant rights to create and edit XML or SQL queries. 
Query “Name” Grant rights to use individual queries created in you.trace.it. 
Track and Trace Grant rights to perform trace forward, backward or till

operation. 
User Assignment Grant rights to assign rights to users or user groups. 
Other Grant rights to perform custom-defined actions or access 

queries created in you.trace.it. 
Archive Administrator Grant rights to manage archives. 
Quality Reports Grant rights to manage Quality Reports. 
Report/Label Grant rights to view individual reports and labels. 
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Assign user rights 

Proceed as follows to assign rights to users or user groups: 

1  Point to the User Rights folder and select the action or class to which you want to assign user 

rights. 

2  Click  in the toolbar: 

 
3  Double-click the user or user group who must have access to that class / perform an action. 

4  Click OK. 
The user or user group is added to the grid: 

 
Only the selected user is granted access to the process stage Production. 

CHAPTER 9 
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Reporting & Labelling 

You can design quality reports for lot IDs. Quality 
reports are exported to MS Excel and contain 
information concerning the quality and life cycle of 
lot IDs.  

Classes may also feature pre-configured report and 
label designs. They offer a means to print the grid 
contents or the selected record in a fixed manner. 
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Quality reports 

What is it 

A quality report retrieves information from the database for the selected lot ID, the 
related quality records in the database, linked lot IDs in other process stages, etc. 
Quality reports allow to gather information concerning the quality and life-cyle of a lot 
ID in one MS Excel worksheet.  

Design 

Report designs consist of a collection of attributes selected by the user from a 
complete list of attributes in the database. A report design lists the pieces of 
information in the database that give a clear view on the quality characteristics of a lot 
ID and its parent or child lot IDs in subsequent or previous process stages.  

Name

Type of geneology data in report 

Attributes to be included in report

 

Organise 

You can create multiple designs for quality reports and organise related designs in 
subfolders of the Quality Reports folder in the folder list. 
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Retrieve 

To generate a Quality Report for a lot ID, just select it in the grid and hit the Quality 
Reports button. The corresponding data will be retrieved from the database and 
presented in a MS Excel worksheet.  

The example below displays the worksheet that is generated with the report settings 
shown in the Design chapter above for a lot ID in the reception stage. 

Same example, but without lot genealogy turned on: 

Remarks: 

• The report title does not mention the lot ID if multiple lot IDs were selected. 

• If lot IDs from different process stages feature identical attributes, those values 
appear in the same column, as from version 3.2. Reports no longer contain 
duplicate columns, e.g. for lot IDs (see above). 

• Report top, bottom, left and right edges feature thin border lines. 

Linked lot ID(s) in subsequent process stage 
(Forward) with selected attributes

Lot ID for which a Quality 
Report is generated

Selected attributes for lot IDs 
of process stage Reception
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Design quality reports 

Proceed as follows to design quality reports: 

1  Go to the Quality Reports folder. 

2  Click  in the toolbar to create a subfolder, e.g. Intake Reports. 

3  Expand the subfolder and click  in the toolbar. 
The following window pops up: 

 

4  Enter a name for your report. 

5  If you want the report to contain lot genealogy information (tracking & tracing) about the 
selected lot ID, select the T&T direction, i.e. Forward or Backward.  
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6  To start adding attributes, click  on the Report Structure tab. 

The Report Layout window appears: 

 

7  Tick the checkboxes of the attributes to be included in the Quality Report. 

"Lot ID" is always included. Expand related quality controls and base tables to include 
information that also relates to the lot ID, but is stored in other database tables, e.g. name of 
the supplier, quality characteristics stored in linked quality records. 



 you.trace.it user’s guide |Geert Vanoverschelde 89

8  Click OK to finish. 

Selected attributes are listed in the Report Structure: 

 Rearrange the order of appearance of the attributes in the quality report by means 
of drag and drop. 

9  Click the Template Usage tab to include a MS Excel template. 

 See “Use templates” on page 90. 

10  Click OK to save the report design. 
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Use templates 

You can now specify MS Excel templates (.xlt file) for quality reports in order to include 
your corporate logo. The template must be set once and is used each time the report is 
generated. Proceed as follows to include an MS Excel template for a quality report: 

1  Select the Template usage tab.  

 
2  Select the option Open Excel template on address.  

 If you do not want to use a template, select Start new Excel workbook each 
time.  

 

3  Click … to choose an *.xlt template file. An example: 

  
4  Click OK to finish. 

The resulting report layout may be as follows:  
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Retrieve quality reports 

Proceed as follows to generate reports for lot IDs: 

1  Select the lot ID(s) for which you want to generate a report: 

 
2  Click Quality Reports in the toolbar. 

The Report Selection window appears: 
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3  Double-click the Quality Report to be generated for the selected lot ID. 
MS Excel is started and the report is built: 

 
 If a genealogy contains the same lot ID more than once, the quality report 

mentions its attributes and quality controls only once. Subsequent appearances 
of the lot ID are marked with: (supra). 

4  Now, format, save or print your report. 
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Print reports and labels 

A report is a pre-designed layout for presenting the grid contents of a class in a 
structured way, including calculated totals, sorted in distinct groups (e.g. per date or 
supplier), page and report headers and footers, etc. 

In you.trace.it, you can only preview or print the report. You cannot edit it. 

Proceed as follows to preview or print a report: 

1  Right-click the grid and point to Reports. 

Choose the report layout to be used to print/preview the grid contents: 
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The report is previewed: 

 

 

2  If you select Labels, the label layout for the record is previewed: 

 
 Depending on the type of report, the report or label will display the data for 

the current record or all records visible in the grid. 
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CHAPTER 10 

Archiving & Database 
Management 

You can create archives of lot ID records as a backup 
to keep your database up-to-date, manageable and 
performant. 

Moreover, you can manage the databases in your 
instance of MSDE or SQL Server using the Database 
Management console in you.trace.it (backup, restore 
or drop). 
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Archiving you.trace.it data 

 Only available to users with Archive Administrator rights. 

About archives 

To allow the usability of extensive databases, you can archive lot ID records. Archived 
records are cleared from the class grids and stored as an archive in the Archives folder: 
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Each record in the Archives folder represents a set of archived lot ID records. 
The following information is listed: 

Item Description 

Requested by User logged on to you.trace.it who created the archive 

Rows Number of archived records 

Reference date Lot ID records with end-time equal or prior to this date were archived 

Backup Completed If ticked, backup is completed successfully 

Archiving Completed If ticked, backup process is finished 

On-line If ticked the archive is currently restored for access 

Backup Device Name Name of the archive 

Create archives 

Proceed as follows to create a new archive: 

1  Go to the Archives folder and click the New button. 

The following window appears: 
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2  Select the Reference Date. All lot IDs prior to this date will be cleared and archived. 

3  Tick the checkboxes of the process stages, for which you wish to archive the lot IDs that have an 
end-time prior to the reference date.  

4  Click Next. 
The following window appears: 

 

5  Tick the checkboxes of the linked classes (M:N relationship) if you want them to be archived. 

If lot ID records refer to other records, those records will be archived, too. 
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6  Click Next. 

The following window appears: 

 

7  A summary appears of the lot ID records about to be archived. Click Next to continue. 

The following window appears: 
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8  Click Finish, then Yes to start archiving. 

 

9  Click OK to finish backing up data and start creating the archive. 

10  When archive creation is completed, click OK to confirm. 
The archive is added to the Archives folder. 

 

Both checkboxes Backup Completed and Archiving Completed are ticked. 

Restore archives 

To consult archived data, you must log in to the archive. you.trace.it restores the data 
in the selected archive, which makes the records accessible (read-only). 

Proceed as follows to restore archives: 

1  Select the archive to restore. 
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2  Right-click and point to Log In To Archives. 

The archive is restored: 

 

3  Click OK to continue.  

you.trace.it logs on the restored archive with read-only permissions: 

 

4  Click Yes to continue. 

you.trace.it switches to the restored archive, see application title caption below. 
To return to the original operational database, go to the Application menu and 
point to Return to Operational Database: 
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5  Click Yes to confirm logging off from restored archive and returning to the 
database you were previously connected to. you.trace.it requests you to log in 
again. 

 The restored archive remains online until it is removed from the database. 

To remove the archive from the database again, use the Drop Online 

Archives command.  
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Drop online archives 

When archives are online, the data is restored into the database. To physically remove 
those records from the database, you must drop the online archives. 

Proceed as follows to drop online archives: 

1  Select the online archive to drop. 

2  Right-click and point to Drop Online Archives: 

 

3  Click Yes to confirm dropping the archive. 

4  Click OK to confirm successful removal. 

 

The Online checkbox is cleared. The archive is available, though. 
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Managing MSDE databases 

Using SQL Server terminal 

The SQL Server Desktop Engine (MSDE) does not have a user interface to manage 
existing databases. However, a SQL Server terminal is available from \Microsoft SQL 
Server\MSSQL\Binn directory to allow users to interact with the contents of the MSDE. 

Open session 

To open the SQL Server terminal, proceed as follows: 

1  Make sure MSDE is running. 

2  Select Run from the Start menu and type command, press Enter. 

3  Type ’osql -E’ at the prompt when your MSDE uses NT security. Press Enter. 
- or - 
Type ’osql -U sa -P’ at the prompt when your MSDE uses SQL security. Press Enter. 
A SQL Server terminal session is started. 

 
1  Type EXIT to close the SQL Server terminal session. 
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Create databases 

To create a MSDE database, use the CREATE DATABASE command: 

1  Type command and database name at the command prompt: 

1> CREATE DATABASE mydb 

1  Press Enter. 

2  Type go at the command prompt: 

2> GO 

1  Press Enter. 
A database named mydb will be created. 

Delete databases 

To delete a MSDE database, use the DROP DATABASE command: 

1  Type command and database name at the command prompt: 

1> DROP DATABASE mydb 

1  Press Enter. 

2  Type go at the command prompt: 

2> GO 

1  Press Enter. 
The database named mydb will be deleted. 

 



 you.trace.it user’s guide |Geert Vanoverschelde 106

Backup databases 

Backing up, and restoring, MSDE databases may be useful to copy databases from one 
server to another. 

To backup a MSDE database, use the BACKUP DATABASE command: 

1  Type command, database name, path and file name at the command prompt: 

1> BACKUP DATABASE mydb TO DISK = 
’C:\Backup\mydb.bak’ 

1  Press Enter. 

2  Type go at the command prompt: 

2> GO 

1  Press Enter. 
The MSDE database, mydb, will be backed up to a file named mydb.bak in c:\Backup. 

Restore databases 

To restore a backed up MSDE database, use the RESTORE DATABASE command: 

1  Type command, database name, path and file name at the command prompt: 

1> RESTORE DATABASE mydb FROM DISK = 
’C:\Backup\mydb.bak’ 

1  Press Enter. 

2  Type go at the command prompt: 

2> GO 

1  Press Enter. 
c:\Backup\mydb.bak will be restored to a MSDE database named mydb.  

 If CANNOT FIND SPECIFIED PATH NAME "<PATH NAME>" 

appears, create the missing directories. 

1  To test whether the database was properly restored, type: 

1> SELECT * FROM <Database.dbo.TableName> 
2> GO 

1  Press Enter. 
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Using Database Management in you.trace.it 

you.trace.it now contains a management console to backup, restore or drop 
you.trace.it databases.  

Backing up or restoring does not affect the data contained in the active you.trace.it 
database. 

Open console 

To start the console, go to the Application menu and point to Database management. 
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Backup database 

Proceed as follows to backup a you.trace.it database: 

1  Click Backup in the console. 
The following window pops up (with empty fields): 

 

1  Select the SQL server in the network or type ’(local)’ when the database is located in an instance 
of SQL server run by the same computer that runs you.trace.it.  

2  Select the login method for the SQL server: Windows NT integrated security (user name and 
password to connect your PC to the LAN is used) or specific user name and password for the 
SQL server (’sa’ account). 

3  Select the database to backup. 
Name and Description are completed automatically based on the name of the database. 

4  Click OK to start. 

 



 you.trace.it user’s guide |Geert Vanoverschelde 109

Restore database 

Proceed as follows to restore a backup of a you.trace.it database: 

1  Click Restore in the console. 
The following window pops up (with empty fields): 

 

2  Select the SQL server in the network or type ’(local)’ when the backup is stored in an instance of 
SQL server run by the same computer that runs you.trace.it.  

3  Select the login method for the SQL server: Windows NT integrated security (user name and 
password to connect your PC to the LAN is used) or specific user name and password for the 
SQL server (’sa’ account). 
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4  Click ... to select the device to be restored. 
The following window appears: 

 

5  Select the device, which is a you.trace.it backup stored in the default backup directory of MS 
SQL Server. 

6  Click OK to start. 
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Drop database 

Proceed as follows to delete a you.trace.it database: 

1  Click Drop in the console. 
The following window pops up: 

 

2  Select the SQL server in the network or type ’(local)’ when the database is located in an instance 
of SQL server run by the same computer that runs you.trace.it.  

3  Select the login method for the SQL server: Windows NT integrated security (user name and 
password to connect your PC to the LAN is used) or specific user name and password for the 
SQL server (’sa’ account). 

4  Select the database to delete. 

5  Click OK to start. 

 


